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Tips for Formatting Turabian Papers Using Microsoft Word 2013
Formatting Turabian papers using Microsoft Word 2013 (the current edition available in the PSC Writing Lab) can be challenging if you are not used to using the software. Luckily, Microsoft has several built-in shortcuts and tools that can help to simplify formatting your paper to Turabian standards. Most professors who require the use of Turabian format will provide their own instructions on how to format your paper. Always defer to your professor’s instructions when formatting your paper. Use the following tips to assist you in formatting your Turabian paper.

Margins
Turabian (8th edition) requires that papers have a one-inch margin on all sides of each page. To set your margins so that they adhere to Turabian guidelines, use the following steps:

1. Press the “Ctrl” and “A” keys on your keyboard at the same time to select the entire paper (even if you do not have anything written yet, doing so will ensure that the margin settings apply to the entire paper, not just the first page).
2. Click on the “Page Layout” tab of the Word menu.
3. Click on the “Margins” dropdown menu button.
4. Select the “Normal” option showing one-inch margins on each side of the page.
[image: ]

Spacing

According to Turabian, your entire paper should be double spaced except for block quotations. Use the following steps to double space your paper:

1. Press the “Ctrl” and “A” keys on your keyboard at the same time to select the entire paper (even if you don’t have anything written yet, doing so will ensure that the double spacing applies to the entire paper, not just the first line).
2. Click on the expand button ([image: ]) in lower right-hand corner of the “Paragraph” section of Word’s “Home” menu to open paragraph window (see image below for more detail).
[image: ]
3. Once in paragraph window, select “Double” from the “Line Spacing” drop-down menu.
4. Make sure that both the “Before” and “After” fields say “0 pt” to remove/prevent any extra spacing.
5. Check the box next to “Don’t add space between paragraphs of the same style.”
6. Before closing the paragraph window, make sure that it resembles the example below.
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Title Page
Turabian requires that papers begin with a title page. Your Turabian title page should at minimum include the title of your paper, your first and last name, your course/class information, and your paper’s due date. Your title page information should be centered, double spaced, and typed in 12-point Times New Roman (ALL text in your paper should be double spaced and in Times New Roman 12pt). Follow the following steps to format your title page correctly:

1. Start on the first line of your paper’s first page.
2. Click on the center button ([image: ]) in the “Paragraph” section of Word’s “Home” menu.
3. Click on the bold button ([image: ]) in the “Font” section of Word’s “Home” menu.
4. Press the “Enter” key on your keyboard five or six times so that your cursor is approximately one third of the way down the page.
5. Type your paper’s title (e.g., Successful Plundering: The Blackbeard Method). If your paper has a subtitle (“The Blackbeard Method” in the sample above), press the “Enter” key on your keyboard and place it on the line directly underneath your main title. 
6. Click on the bold button again to turn off  bold.
7. Press the “Enter” key on your keyboard five or six times so that your cursor is approximately two thirds of the way down the page.
8. Type your first and last name.
9. Press the “Enter” key once.
10. Type your class name.
11. Press the “Enter” key once.
12. Type the paper’s due date.
13. To move on to the next page of your paper, press the “Ctrl” and “Enter” keys at the same time to insert a page break.

Your title page should look similar to the sample below:
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Some professors may require that you include other information (e.g. your institution’s name,  your professor’s name, etc.) on your title page or that you format your title page differently (e.g. putting the title in ALL CAPS). If your professor asks for any more information or for alternate formatting, defer to your professor’s instructions and include all information they may require.

Page Numbers
Turabian requires that papers have page numbers in the upper right-hand corner of every page. To insert page numbers that will automatically carry over onto every new page of your document, use the following steps:

1. Click on the “Insert” tab of the Word menu.
2. Click on the “Page Number” dropdown menu button. 
3. Click on the “Top of Page” submenu.
4. Select the “Plain Number 3” option that shows the page number appearing on the right-hand side of the header.
[image: ]

5. Press the “Ctrl” and “A” keys on your keyboard at the same time to select all text in the header and change the font to Times New Roman 12pt so that it matches the font of the rest of your paper (ALL text in your paper should be in Times New Roman 12pt).
6. Click on the “Header and Footer Tools Design” tab at the top of the page.
7. Check the box beside the “Different First Page” option (this step will appear to delete your page numbers, but once you make it onto the second page of your paper, the page numbers you have already inserted will reappear).

[image: ]

Blank Page
Although the current edition of the Turabian style guide does not require a blank page following the title page, some professors require that this feature in their Turabian paper assignments. If your professor requires the addition of a blank page, your page numbers should not begin until the second page of your paper with the number 2. Use the following steps to add a blank page following the title page and to reformat your page numbers to reflect this additional page:

1. Press the “Ctrl” and “Enter” keys on your keyboard at the same time twice to insert a page break between your title page and the second page (the page that will remain blank) and between the blank page and the first page of your paper’s main text.
2. Click on the “Page Layout” tab of the Word menu.
3. Click on the “Breaks” dropdown menu in the “Page Setup” section.
4. Select the “Next Page” under “Section Breaks.”
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5. Double click into the header of your third page.
6. Unclick the “Link to Previous” button in the “Navigation” section of the “Header and Footer Tools” tab (button should appear as in image below, not highlighted in orange).

[image: ]

7. Click on the “Insert” tab of the Word menu.
8. Click on the “Page Number” dropdown menu button. 
9. Click on the “Top of Page” submenu.
10. Select the “Plain Number 3” option that shows the page number appearing on the right-hand side of the header.
[image: ]

11. Press the “Ctrl” and “A” keys on your keyboard at the same time to select all text in the header and change the font to Times New Roman 12pt so that it matches the font of the rest of your paper (ALL text in your paper should be in Times New Roman 12pt).
12. Click on the “Insert” tab at the top of the page.
13. Click on the “Page Number” dropdown menu button.
14. Select the “Format Page Numbers” option to open a dialog box.

[image: ]

15. Select the “Start at” option, set it to 1, and click the “OK” button.

[image: ]

16. Click on the “Header and Footer Tools Design” tab at the top of the page.
17. Check the box beside the “Different First Page” option (this step will appear to delete your page numbers, but once you make it onto the second page of your paper’s text, the page numbers you have already inserted will reappear).

[image: ]

You should end up with your title page (no page number), a blank page (no page number), your paper’s first page of text (no page number), and the rest of your paper and your bibliography with page numbers starting at 2 and continuing on every page.

Paragraph Indents
According to Turabian, all paragraphs should be indented one half (.5) of an inch. To set Word to automatically indent your paragraphs each time you hit the “enter” key on your keyboard, use the following steps:

1. If you are unable to see a ruler between the bottom of the Word menu and the top of your page, perform these steps before moving on to step two:
a. Click on the “View” tab of the Word menu.
b. Check the box beside the “Ruler” option of the “Show” section of the menu.
c. Now the ruler should be visible as shown below.

[image: ]

2. Now that you can see the ruler, you can add your indent. Hit the “Enter” key to move onto the line directly below your title (there should be no extra lines between your title and the first line of your paper’s first paragraph) and click on the left justify button 
([image: ]) to return your cursor to the left-side margin of your page.
3. Click and drag the top triangle on the ruler’s left-hand margin so that it sits on the line halfway between your left-hand margin and the “1” on the ruler. Your ruler should end up looking like the example below.

[image: ]

Now Word will automatically indent half an inch every time you hit the “Enter” key to move on to a new paragraph.  If you need to remove this automatic indent for any reason, all you have to do is place your cursor before the indent and press the “Backspace” key to delete it.

Inserting Footnotes
Turabian uses footnotes to mark in-text citations. Every time that you quote or paraphrase an outside source, you will have to insert a footnote to cite that source. To insert footnotes in Word, use the following steps:

1. Place your cursor at the end of your quote or paraphrased information.
2. Click on the “References” tab of the Word menu.
3. Click the “Insert Footnote” button in the “Footnotes” section.

[image: ]

4. Double click into the footer where the footnote has appeared.
5. Type the citation information for your quote or paraphrase directly following the footnote (notice that the footnote uses commas in place of the bibliography’s periods).
6. Make sure that the text following the footnote (not the footnote number itself) is in “Times New Roman” 12pt.

Your finished footnote should appear at the bottom of the page as follows:

[image: ]

Footnotes will automatically appear in the order of the text they are referring to, so if you add a footnote in the middle of two other footnotes, the footnotes will automatically reorder so that they are sequential. For more information on Turabian style footnotes, please consult the Turabian style manual or your professor’s instructions when available.


Block Quotations
Turabian states that when a quotation is five or more lines of text, it should be formatted as a block quote. Block quotes are set apart from the text of your paragraph and indented one half (.5) of an inch from the left margin. To correctly format a block quote, use the following steps:

1. First, introduce your lengthy quote with a complete sentence and a colon (:), an introductory phrase and a comma, or an incomplete sentence that leads directly into the quote without punctuation.
2. Type out your quoted material without any quotation marks (the block format will take the place of quotation marks to show that the material is from another source). 
3. Be sure to insert a footnote following the quote.
4. Now, type another sentence addressing your quote (this step is important both for your paper’s effectiveness and for the formatting of your block quotation).
5. Place your cursor before the quote and press the “Enter” key as if you are starting a new paragraph.  If you have automatic indents set, press the “Backspace” key once to remove the indent.
6. Place your cursor before the sentence following your quote and press the “Enter” key as if you are starting a new paragraph.  If you have automatic indents set, press the “Backspace” key once to remove the indent so that the remaining text of your paragraph after the quote will start at the margin, eliminating any confusion for your reader.
7. Select the entire quote and citation.
8. Press the “tab” key once to indent the entire quotation one half inch from the margin.
9. Your block quote should end up looking like the example below.

[image: ]

Try not to use too many block quotes in your paper. Your own words should make up the bulk of your paper’s text.


Hanging Indent
Each citation on your Bibliography page should be formatted with a hanging indent.  A hanging indent occurs when the first line of the citation begins on the left-hand margin and the second line of the citation is indented half an inch from that margin.  To format your Bibliography page using hanging indent, use the following steps:

1. Place your cursor at the very end of your paper and press the “Ctrl” and “Enter” keys at the same time to create a page break.
2. If Word automatically indents on the new page, press the “Backspace” key once to delete the indent.
3. Click on the center button ([image: ]) in the “Paragraph” section of Word’s “Home” menu.
4. Type “Bibliography” (without quotation marks) as your title.
5. Press the “Enter” key and click on the left justify button ([image: ]) to return your cursor to the left-side margin of your page.
6. Type out all of your References page citations, pressing the “Enter” key after each citation.
7. Select all of your citations, but do not select page’s title.
8. Press the “Ctrl” and “T” keys at the same time to format your hanging indent automatically.
9. Your citation(s) should end up looking like the example below.

[image: ]

The citations on your Bibliography page and your footnotes should follow Turabian guidelines. For more information regarding Turabian citations, please consult the Turabian style manual or your professor’s instructions when available.



Ashley Lynne Massie Summer 2015
image3.png
@HS 00> Tips for Formatting MLA Papers Using Microsoft Word 2013.docx - Word ? @ -

BTl ‘ove | NSRT  DESIGN  PAGELAYOUT  REFERENCES  MALINGS  REMEW  VIEW StudentDEY -
Cut TimesNewfo <12 | & &7 Aa- o 5w #orind -
0 & con imes A & E AsBOCL AsBbCel AsBDC( AcsbCcl AQB assbeer daBsCel daBbCel dasbCel [ g ol
Paste - . 9 LAy - = - lormal lo Spac. leading leading itle ubtitle ubtle Em. ‘mphasis  Intense N
e e e B U wexx AW A S0 | TNomsl TNoSpc. Hedingl Headng?  THe | Sublile Subtlefm. Emphasic Intensef [
apbos Font 5 Paagrapn = syes 5 g A
I ° : 2 s s s . = ; =

Some perotessors require that you mclude other mtormation (e.g. the paper’s word count) 1 your

heading. This information should be included on the line directly following the header

(underneath the date). If your professor asks for something other than the standard MLA header,
N defer to your professor’s instructions.

Spacing

According to MLA, your entire paper should be double spaced. Use the following steps to
double space your paper:

1. Press the “Ctr]” and “A” keys on your keyboard at the same time to select the entire
paper (even if you don’t have anything written yet, doing so will ensure that the double
spacing applies to the entire paper, not just the first line).

2. Click on the expand button () in lower right-hand corner of the “Paragraph” section of
Word’s “Home” menu.

3. Select the “2.0” option.

Titles





image4.png
EHS 0D+ Document2

ETR ove SR OSION  PAGCLYOVT  RGERNCES  MALNGS  RemW  viEw p———
% cue ¢ = #Find -~
ﬁgawy TmesNewRo w12 *| & & A2 = AaBbCCl AsBbCel AsBDC AcsbCel AQB assbeer daBsCel daBbCel dasbCel [ g ol
Gipboard 5 Font syies 5 eatng A
& f n % ) : ) 2 ) 3 ) i B s B . » ;
e - -
N {Indents and Spacing ' | Line and Page Breaks
Generat
Agnment: [ Left =
Outine levet: [BodyTert [=] L] Collapse by defaut
Edward Teach
Indentation
. Lot o Specit: o
i Professor Kidd — -
Right: 0] + (none) i 2
Mitorndents
Plunder 101
§ Spadng
Before: opt Line spacing: At
19 September 2015 atter opt Double 2 z

Don't add spage between paragraphs of the same style

Successful Plundering: The Blackl|

Preview

Tose | [sethspetmit o Gl

PAGELOF1 14woRDS (B % p——r
526PM

= el ol® e




image5.png
B HS 0D -

EER o | NSERT  DESGN  PAGELAYOUT  REFEReNCES

iy 2 TimesNewRo <12 <| A A Aa- e

e B I U O-¥

T Format Painter 4 - aex C¥- A
aipboard Font .

i B

i i

Tips for Formatting MLA Papers Using Microsoft Word 2013 docx - Word

MAILINGS

"=
=

Paragraph
2

RevEw VW
20T AaBbCdl AaBbCel AaBbC( AsgbCet AQB asebcer daBsCel AaBbCel tazbcel
= syes

?

3 i 4 i s i

2}
Your title should also be centered according to MLA format guidelines. To center your title, use

the following steps:
1.

Select your entire title.

2. Click on the center button () in the “Paragraph” section of Word’s “Home” menu.

Paragraph Indentions

Block Quotations

G A 7

= x
P— |
i Find -
25c Replace
It Select~





image6.png
rosoft Word 2013

H9-0 ips for ing Turabian Papers Using

|oEh|

[luwvew.regent.edu/ X

e o e

@ 4 TmesNewRoman  -|12 -
G (B2 U x % |[F)] |

J
I[34){ar]

A A

‘ | AA][A (- Styles - Styles~ ||~
] RN EEEF KXKNEREN KXEN KXY KRN ERRE KERNRREN

~|  Tubisnrequiresthat papersbegin witha title page. Your Turabiantitle page shouldat
‘minimum include the tile ofyour paper, your first and last name, your course classinformation,
andyourpaper's due date. Yourtitle pageinformationshouldbe centered, double spaced, and
typedin 12-point Times New Roman (AL textinyour paper shouldbe double spaced andin
Times New Roman 12pt). Follow the following steps to format your title page correctly:

N 1. Startonthe frstline of yourpaper's first page. g

2. Chik onthe coter o ( T3 inthe -Fragaph” setionf Word's“Horne” e
- 5. Click onthe boldbutton ()in the “Font”section of Word s “Home™ mem1.

4. Pressthe “Enter” key onyourkeyboard i or s tims.

5. Type yourpaper's tlle e 2. SUCCESSFUL PLUNDERING: THE BLACKBEARD
o METHOD) Ifyourpaperhas  subtitle(“THE BLACKBEARD METHOD" inthe

sample above), press the “Enter”key on yourkeyboard andplaceit on thelne directly

- undemeathyourmaintite.

6. Pressthe “Enter” key onyourkeyboard three times.

7

Yourtitle page shouldlook similarto the sample below:

implePaperandTurabianBasics.pdf

No page numl

The title of your paper should
be bold, centered, double-

spaced, and a third of the w
down the page (376).

Inguage:

\d’s Tangible Presence

ame, course name, and due
date should be on separate

non-bold, centered,
2/3rds down the page, and
double-spaced (376).

| fhe New Testament

[§2009

Fage: 2017 | Wordsi198 | B |





image7.png
Insert

Page Layout

References

‘Suceessful Plundering:

‘The Blackbeard Method

Edward Teach
‘Plundering 101
September 19,2015





image8.png
EHS 00> Document? - Word ? @3 - x
EER v NSRT  DION  PAGELAVOUT  REFERENCES  WALNGS  RedEN VW p——
B Coverpager == [= P @ Hypertink 3 = = [¥ SignstureLine - T Equation -
Do S DO Dl @ @ WO RER 0D A A e g
o Table  Pictures Online Shapes SmatArt Chart Screenshot g py apps - Wikipedia | Online Comment Header Footer Page  Tet Quick WordAtt Drop -
HPagetreak Picures  + - Video B Cross reference © - Numbert Boc Pans- - Copr [JObject -

Pages | Tables stations A Simple S| B Topofpage »| et Smbots A
2 B : 8 : t : 2 Plsin Number 1 B Sottomof Page e & 7
. B} Page Margins »

' B Corrent Position »
Py Format Page Numbers.
i Plain Number 2 B Remove Page Numbers
Teach 1
Edward Teach Plain Number 3
1 Professor Kidd
PageX
i Plunder 101 ot
19 September 2015 e
SuccgAccent Ber2 od
Gl
@ More Page Numbersfrom Office.com .

E By Save Seection a Page Number Top)

E10F1 14 ————+
36 PM

=i 112/2015




image9.png
Home  Insert  Pagelsjout References w

= g 5 Previous Section | 9] Diterent FirstPage . Headertom Top: [0

T Newsecion | [ Different 0dd & Even Pages | = Footerfrom Bottom: 05”
Header Footer Page || Date Quick Picure Goto Goto Close Header
el 1 et i Favter B Unkto previous || 9] Show Document Text 3 insert Algnment Tsb e fastes

Header & Footer Insert Navigation Options Position Close

o] 1





image10.png
% Home  Insert | Pagelaout | References  Maings  Review  View

3

Page Breaks
Margins Orientation Size ~ Columns

= e T ==
: o B8 B REHa
- = ostin gte Scngto. Tet  lim o rote

After: 0 pt - Front~ Back~ Wrapping~ ~
' g 2 ! A
Coumn

Text Wrapping
Separate text around objects on web
pages, such as caption text from body text.

Breaks

Continuous
Inserta section break and start the new
Section on the same page.

Even Page
Inserta section break and start the new
Section on the next even-numbered page.

Odd Page
Insert a section break and start the new
Section on the next odd-numbered page.

of10 | Words:189 | <5 |





image11.png
PageLajout  References

g5 Review  View

"
= ﬁ Ty Previous Section

Header Footer Page || Date

 Next Section
Quick Pictwre Clip | Goto Goto

~ Number~ || &Time Parts - At || Header Footer 33 Link to Previous

Header & Footer

Insert Navigation

] Different Frst Page

7] Different Odd & Even Pages

] Show Document Text
Options

S HeaderfromTop: |05

) Footerfrom Bottom: 05°

(5D tnsert Alignment Tab
position

[

1

First Page Header -Section 2-





image12.png
Pagelajout  References  Mailings

Review

Bl

FEIE T

View

A= [ signatureine -

Cover Blank  Page || Table | Picture

Page~ Page Break || -
Pages Tables

Clip Shapes Smartart Chart
i

Hlustrations

[

First Page Header -Section 2-

) Date axtime
Ted  Quick Wordat Drop
Box~ Parts- - Cap- '$8Object~

Top of Page

T Q

Equation Symbol

Symbols

Bottom of Page
Page Margins
Current Position

Remove Page Numbers
Format Page Number
Change the format of page

numbering used in the header or
footer,





image13.png
Document - Microsoft Word

~ Header & Footer Tools

Home | Insert

Poge oot Reterences_ Woiings_ Revew Vi Desan
I = 3] = A~ (&signature Line -
[ R =] = 2 =i T @
(3} Date & Time
Cover Bank Page || Table || Pidme Gl Shapes Smarart Chat | yperink Baokmark Crosseference | Header Footer Fage || Tet  Quick WordArt Drop Eauaton Smbel
Page~ Page Break - Art - - < Number-  Box- Pamst -  Cap- '"$dObject~ - -
= Toes ustons s Heaser uFooter Test symbols

First Page Header -Section 2-

Page Number Format

Number format:

12,3,

Indude chapter number

‘Chapter starts with stye: |Heading 1

- (yphen)
11,14

Use separator:
Examples:

Page numbering
© Continue from previous section
@ startat: |1 B

-

“Turabian Template (1) 1,034 characters (an approximate valuel.





image14.png
EHS 00> Document2 - Word ? @ - x
PV o s ouon  pccieouT e wAtns e v P—
X cut - < #Find -

ﬁE@ . TimesNewRo-[12 -| A" & A2 AaBbCel | AaBbCL AaBbC( Aasbcct AQBI asebcer daBbcel daBbCel samscer |, e
Paste - 3 lormal lo Spac... ing ing itle: ubtitle ubtle Em... Emphasis  Intense E... N
e pumes BT U x TNormal | TNoSpac.. Headngl Heading?  Tile  Sublie  SubtieEm.. Emphasis Inense X st
Cipboara 15 Font siytes 5 eatng | A
o R g ' 2 f . B . =
Teach 1

E10F1 14

Edward Teach|
Professor Kidd
Plunder 101

19 September 2015

Successful Plundering: The Blackbeard Method





image15.png
@HS 00> Tips for Formatting MLA Papers Using Microsoft Word 2013.docx - Word ? @ -

Ul foME | INSIRT  DESGN  PAGELAYOUT  REFERENCES  MALINGS  REVEW  VIEW StudentDEV -
% cut . B s #Find -

i B2 Copy TimesNewRo -[12 -] A" &"[ A~ | % B aaBbCd AaBbCel AaBbCe Aasbcet AQBI nasbcer daBbCel daBbCel sampcel [ e

Paste - . - Loaly - = - lormal lo Spac. leading leading itle: ubtitle ubtle Em. mphasis  Intense N

e e e B U wexx AW A S0 | TNomsl TNoSpc. Hedingl Headng?  THe | Sublile Subtlefm. Emphasic Intensef [

apbos Font 5 Paragraph = syes 5 g A
i 2 f . s . » ; =

v
Accor(ﬁng 10 IVILA, all paragraphs should be mdented one hait (.5) Of an mch. 10 set Word 1o
automatically indent your paragraphs each time you hit the “enter” key on your keyboard, use the
following steps:

L i

1. If you are unable to see a ruler between the bottom of the Word menu and the top of your
page, perform these steps before moving on to step two:
a. Click on the “View” tab of the Word menu.
b. Check the box beside the “Ruler” option of the “Show” section of the menu.
B c. Now the ruler should be visible as she below.

paste B I U-moxx A-%-A- Hedng? T st SubteEn. 6

2. Now that you can see the ruler, you can add your indention. Hit the “Enter” key to move
onto the line below your title and click on the left justify button () to return your cursor to

N the left side margin of your page.
Block Quotations
R Hanging Indent

PAGE3OF3 916woRDs [ &





image16.png
EHS 0D0-> Document? - Word ? @3 - x
ETR vove  WSET DN PAGELAOUT | REERENCES  MALNGS  REBW VW P—_
X% cut . ] #Find -

ﬁﬁacam TmesNewRo w12 *| & & A2 AsBbCAl| AsBbCel AaBbCc Aasbcet AQB aasbcer daBocel daBbCel dambCel [ g0l
Pt a8 T Ut X Thomal | TNoSpac.. Hesdingl Heading?  Tde  Subitle SublleEm. Emphass IntenseEu | | qopo
Cipboara 5 Font siytes 5 eatng A
& f A ' 2 f . s . »
Teach 1

Edward Teach
1 Professor Kidd

Plunder 101

19 September 2015

E10F1 14

Successful Plundering: The Blackbeard Method





image17.png
@ Home  Inset  Pagelayout | References | Maiings  Review  View

e AdaTent - setinancis | [N Mmgesouces || J) et Tt rigues mseinser | gz e e adnoris
L Update Table A8 NextFootnote - | =Y (3 syle: APAFifr - 2 Update Table M Update Index 2 Update Table
Table of Insert Insert et Mk Mk
Contents ~ Footnote =] Show Notes Citation - @ Bibliography = || Caption [4) Cross-reference Entry Citation
Table of Contents Footnotes 5 Gstions & ibliography Coptions index Table of Authortes
(o] 1 i X | i | 3 | 5 | | S | © & 7

Blackbeard and his crew were some of the most successful pirates on the open seas. This
Success stemmed from their ability to use effective pirating tactics to prey on unsuspecting ships
Blackbeard and his crew used on specific tactic to great success

They ambushed ships camrying passengers and cargo in the dim light of dawn and dusk

when the pirates” ship was hard to see. The pirates often determined 2 ship’s nationality

first. Then they raised that country’s flag on the pirate ship so they appeared tobe
friendly. Now able to draw close to the unsuspecting ship, the pirates hoisted

Blackbeard’s flag only at the last moment.!

By giving victim ships a false sense of security, Blackbeard and company were able to use the

element of surprise to their advantage. After successfully ambushing the target ship, they would

‘begin the process of boarding and plundering, gathering their booty from the spoils of

assignments





image18.png
Home | nsert References

Page Layout

% R = HArina-

S Colibri Body) n -[a x| aambccoc AaBbC: AaBbce AAB aczbce - A & reioce
P comatpainter || B 4 U~ sbe %, X' Aa-| 22 A-| &) ThoSpac.. Headngl | Hesding2  Te | subiite o Change | To

cippors % Font 5 e 5 e 5| Eating
o] [ RN ERRNRRAS RN KRR KRN RRAR KRR KR KRN RRAR ERR (L)

*Jennifer Kirkpatrick, “Blackbeard: Pirate Terror at Sea,” National Geographic, last modified
2012, http://wwvw nationalgeographic.compirates/bbeard html

“Turabian Template (1) 1,034 characters (an approximate valuel.





image19.png
Home  Inset  Pagelayout | References | Maiings  Review  View

AdaText - setinaneie | [ c9vmge ouces s | o = o
L Update Table A8 NextFootnote - | =Y (3 syle: APAFifr - 2 Update Table M Update Index 2 Update Table
Tableof Insert Insert Insert Mark Mark
Contents ~ Footnote =] Show Notes Citation - @ Bibliography = || Caption [4) Cross-reference Entry Citation
Table of Contents Footnotes % Citations & Bibiiography Captions Index Table of Authorites
(o] 1 i X | i | 3 | 5 | | S | © & 7

Blackbeard and his crew were some of the most successful pirates on the open seas. This
Success stemmed from their ability to use effective pirating tactics to prey on unsuspecting ships
Blackbeard and his crew used on specific tactic to great success

They ambushed ships camrying passengers and cargo in the dim light of dawn and dusk

when the pirates” ship was hard to see. The pirates often determined 2 ship’s nationality

first. Then they raised that country’s flag on the pirate ship so they appeared tobe
friendly. Now able to draw close to the unsuspecting ship, the pirates hoisted

Blackbeard’s flag only at the last moment.!

By giving victim ships a false sense of security, Blackbeard and company were able to use the

element of surprise to their advantage. After successfully ambushing the target ship, they would

‘begin the process of boarding and plundering, gathering their booty from the spoils of
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1. Press the “Ctr]” and “A” keys on your keyboard at the same time to select the entire
paper (even if you don’t have anything written yet, doing so will ensure that the double
spacing applies to the entire paper, not just the first line).
2. Click on the expand button in lower right-hand corner of the “Paragraph” section of
N ‘Word’s “Home” menu.
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